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Disclaimers 
Lattice makes no warranty, representation, or guarantee regarding the accuracy of information contained in this document or the suitability of its 
products for any particular purpose. All information herein is provided AS IS, with all faults, and all associated risk is the responsibility entirely of the 
Buyer. The information provided herein is for informational purposes only and may contain technical inaccuracies or omissions, and may be otherwise 
rendered inaccurate for many reasons, and Lattice assumes no obligation to update or otherwise correct or revise this information. Products sold by 
Lattice have been subject to limited testing and it is the Buyer's responsibility to independently determine the suitability of any products and to test 
and verify the same. LATTICE PRODUCTS AND SERVICES ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE IN LIFE OR SAFETY CRITICAL 
SYSTEMS, HAZARDOUS ENVIRONMENTS, OR ANY OTHER ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, INCLUDING ANY APPLICATION IN 
WHICH THE FAILURE OF THE PRODUCT OR SERVICE COULD LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR ENVIRONMENTAL 
HARM (COLLECTIVELY, "HIGH-RISK USES"). FURTHER, BUYER MUST TAKE PRUDENT STEPS TO PROTECT AGAINST PRODUCT AND SERVICE FAILURES, 
INCLUDING PROVIDING APPROPRIATE REDUNDANCIES, FAIL-SAFE FEATURES, AND/OR SHUT-DOWN MECHANISMS. LATTICE EXPRESSLY DISCLAIMS 
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK USES. The information provided in this document 
is proprietary to Lattice Semiconductor, and Lattice reserves the right to make any changes to the information in this document or to any products at 
any time without notice. 

Inclusive Language 
This document was created consistent with Lattice Semiconductor’s inclusive language policy.  In some cases, the language in underlying tools and 
other items may not yet have been updated.  Please refer to Lattice’s inclusive language FAQ 6878 for a cross reference of terms. Note in some cases 
such as register names and state names it has been necessary to continue to utilize older terminology for compatibility. 
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Abbreviations in This Document 
A list of abbreviations used in this document. 

Abbreviations Definition 

AHB  Advanced High-Performance Bus 

AMBA Advanced Microcontroller Bus Architecture 

APB Advanced Peripheral Bus 

CMOS Complementary Metal-Oxide Semiconductor 

CPU Central Processing Unit  

CSI-2 Camera Serial Interface 2 

DE Data Enable 

DPI  Display Pixel Interface  

DSI Display Serial Interface 

DUT Device Under Test  

EBR Embedded Block RAM 

FIFO First In, First Out 

FPGA  Field Programmable Gate Array  

FPU  Floating Point Unit  

GPIO  General Purpose Input/Output  

HDL  Hardware Description Language  

HS High Speed 

HSYNC Horizontal Sync 

I/O Input/Output 

IP  Intellectual Property  

JTAG  Joint Test Action Group  

LED  Light-Emitting Diode  

LMMI  Lattice Memory Mapped Interface  

LP Low Power 

LSB  Least Significant Bit  

LUT Look Up Table 

LVCMOS  Low Voltage Complementary Metal Oxide Semiconductor  

LVDS  Low Voltage Differential Signaling  

MC  Main Controller  

MIPI Mobile Industry Processor Interface 

OpenOCD Open On-Chip Debugger 

PLL Phase Locked Loop 

PRBS Pseudorandom Binary Sequencer 

RGB  Red, Green, Blue  

RISC-V  Reduced Instruction Set Computer Five  

Rx Receiver 

SDK  Software Development Kit  

SoC System On Chip 

STA Static Timing Analysis 

Tx Transmitter 

UART  Universal Asynchronous Receiver/Transmitter  

VSYNC Vertical Sync 
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1. Introduction 
The Mobile Industry Processor Interface (MIPI®) D-PHY was developed primarily to support camera and display 
interconnections in mobile devices, and MIPI D-PHY has become the primary high-speed PHY solution in industry for 
these applications in smartphones. MIPI D-PHY is typically used in conjunction with MIPI Camera Serial Interface-2 (CSI-
2) and MIPI Display Serial Interface (DSI) protocol specifications. This interface meets the demanding requirements of 
low power, low noise generation, and high noise immunity that mobile phone designs demand. 

MIPI D-PHY is a practical PHY for typical camera and display applications which is designed to replace traditional 
parallel bus based on LVCMOS or LVDS. However, many processors and displays and cameras still use RGB, CMOS, or 
MIPI Display Pixel Interface (DPI) as interface. 

The Lattice Semiconductor MIPI-to-Parallel and Parallel-to-MIPI reference design allows the quick interface for a 
processor with a MIPI DSI interface to or from a display with an RGB interface, or a camera with a MIPI CSI-2 interface 
to or from a processor with parallel interface. This reference design provides the conversion for Lattice Avant™ devices 
and is useful for wearable, tablet, human machine interfacing, medical equipment, and many other applications. 

1.1. Quick Facts 
Download the reference design files from the following Lattice reference design web pages: 

• MIPI DSI/CSI-2 to Parallel Bridge Reference Design web page 

• Parallel to MIPI CSI-2 / DSI Display Interface Bridge Reference Design web page 

Table 1.1. Summary of the Reference Design 

General 
Target Devices LAV-AT-E70 

Source code format Verilog 

Simulation 

Functional simulation  Performed 

Timing simulation Performed 

Test bench Available 

Test bench format System Verilog 

Software Requirements 

Software tool and version 

Lattice Radiant™ software version 2025.1 

Lattice Propel™ software version 2025.1 

Lattice Propel Builder version 2025.1 

IP version 

Pixel to Byte 1.9.1 

Byte to Pixel 1.9.1 

CSI-2/DSI D-PHY Receiver 2.0.0 

CSI-2/DSI D-PHY Transmitter 2.3.0 

RISC-V MC 2.8.0 

Hardware Requirements 
Board Lattice Avant Evaluation Board Revision D 

Cable Lattice Programming Cable HW-USBN-2B 

 

1.2. Features 
Key features of the MIPI-to-Parallel and Parallel-to-MIPI reference design include: 

• Compliant with MIPI D-PHY v1.2 and MIPI CSI-2 v1.2 specifications 

• Supports MIPI D-PHY interfacing from 160 Mb/s up to 1800 Mb/s for Avant 03A silicon, or up to 800 MB/s for 
Avant 02A silicon. 

• Supports 1, 2, or 4 data lanes and one clock lane 

• Supports continuous and non-continuous MIPI D-PHY clock 

• Supports bit rate dynamic reconfiguration 

• Supports common MIPI CSI-2 compatible video formats (RGB888, RAW8, RAW10, RAW12, RAW14, RAW16, 
YUV_420_8, YUV_420_10, YUV_422_8, YUV_422_10) 

http://www.latticesemi.com/legal
https://www.latticesemi.com/products/designsoftwareandip/intellectualproperty/referencedesigns/referencedesigns05/mipidsicsi2toparallelbridge
https://www.latticesemi.com/products/designsoftwareandip/intellectualproperty/referencedesigns/referencedesigns05/paralleltomipidsidisplayinterfacebridge
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1.3. Naming Conventions 

1.3.1. Nomenclature 

The nomenclature used in this document is based on Verilog HDL. 

1.3.2. Signal Names 
• _n are active low (asserted when value is logic 0) 

• _i are input signals 

• _o are output signals 

1.3.3. Data Ordering and Data Types 
The highest bit within a data bus is the most significant bit. 8-bit parallel data is serialized to 1-bit data stream on each 
MIPI D-PHY data lane where bit 0 is the first transmitted bit. 
Table 1.2 lists pixel data order going into Parallel2MIPI module or coming out from MIPI2Parallel module. 

Table 1.2. Pixel Data Order 

Data Type Format 

RGB  {Red[MSB:0], Green[MSB:0], Blue[MSB:0]}  

RAW  RAW[MSB:0] 

YUV YUV[MSB:0] 

 

http://www.latticesemi.com/legal
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2. Directory Structure and Files 
Figure 2.1 shows the directory structure. 

 

Figure 2.1. Directory Structure 

http://www.latticesemi.com/legal
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3. Functional Description 

patgen_chk_wrapper

propelbld_soc_w_m2p_p2m

pattern_gen protocol_pktzr

pat_chk

p2b tx_dphy

b2p rx_dphy

serial_loopback_top

parallel2MIPI Reference Design

MIPI2parallel Reference Design

Pixel Data

Pixel Data, 
Sync Signals

Pixel Data

APB Bus

DPHY CLK and DATA 
Lanes over FMC Card

UART

GPIO

soc_w_m2p_p2m_top

resetn_i

JTAG

Configurable PLL clkop, clkos, pix_clk

 

Figure 3.1. Reference Design Block Diagram 

Figure 3.1 shows the high-level block diagram of the MIPI-to-Parallel and Parallel-to-MIPI reference design. The MIPI-
to-Parallel reference design consists of rx_dphy and b2p soft IPs, which convert MIPI CSI-2/DSI D-PHY packets into pixel 
format depending on the data type of the packets. Conversely, the Parallel-to-MIPI reference design consists of p2b 
and tx_dphy soft IPs, which packetized pixel data into MIPI CSI-2/DSI D-PHY packets. 

The MIPI-to-Parallel and Parallel-to-MIPI reference design enables hardware testing by connecting MIPI D-PHY CLK and 
DATA lanes of tx_dphy and rx_dphy together on the board. The stimulus in the form of pixel data is generated by the 
pattern_gen module and is packetized to match with the respective protocol (i.e. CSI-2 or DSI) via the protocol_pktzr 
module. The protocol_pktzr module then sends the pixel data along with control signals to the Parallel-to-MIPI 
interface (for example, frame valid, line valid, data enable, horizontal sync, vertical sync). The pixel data is then 
captured by the pat_chk module from the MIPI-to-Parallel interface to be compared with the transmitted pixel data. 

3.1. Design Components 
The MIPI-to-Parallel and Parallel-to-MIPI reference design initiates and connects propelbld_soc_w_m2p_p2m and 
serial_loopback_top blocks together with the soc_w_m2p_p2m_top module. 

The blocks in the MIPI-to-Parallel and Parallel-to-MIPI reference design are described in the subsequent subsections. 

3.1.1. propelbld_soc_w_m2p_p2m 

This propelbld_soc_w_m2p_p2m module is generated by the Lattice Propel Builder to wrap over the RISC-V and other 
peripherals together. RISC-V, system memory (system0), and AHB-Lite bus run on 100 MHz clock, while APB bus runs 
on 50 MHz clock. Both are generated by PLL0.  
Note: All the IPs and connections for this module are generated in the Lattice Propel Builder software. Any modification 

to this module requires modification with the Lattice Propel Builder software.  

Figure 3.2 shows the high-level block diagram of this module. 

http://www.latticesemi.com/legal
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system0

apb0ahbl0

cpu0

apb_ft_pcg

apb_ft_rxdphy

apb_ft_txdphy

apb_ft_pll

gpio0

uart0

apb0

osc0 pll0
50 MHz

APB Bus to Pattern 
Gen and Checker

APB Bus to Rx DPHY

APB Bus to Tx DPHY

APB bus to sys_pll

led_o[7:0]

rxd_i, txd_o

propelbld_soc_w_m2p_p2m

100 MHz

50 MHz

ref_byp_clock_o (150 MHz)clk50 (50 MHz)

rstn_i

JTAG

 

Figure 3.2. soc_w_m2p_p2m Block Diagram 

This module instantiates the blocks described in the subsequent subsections. 

3.1.1.1. osc0 

osc0 is the on-chip oscillator that supplies 50 MHz clock to be a reference clock for the pll0 in the 
propelbld_soc_w_m2p_p2m block and sys_pll in serial_loopback_top.  

The following guidelines and parameter settings are required for this reference design: 

• HFCLK Enable – ENABLED 

• Frequency – 50 MHz 

• LFCLK Enabled – DISABLED 

• SEDCLK Enable – DISABLED 

• CFGLMMICLK Enable – DISABLED  

3.1.1.2. pll0 

The pll0 is instantiated to generate the necessary clocks required by the design.  

The following guidelines and parameter settings are required for this reference design: 

• Set Maximum Error Option – Find a solution with the lowest error 

• Enable Fractional Accumulation – Unchecked 

• Reference Clock – 50 MHz, coming from on-chip oscillator output . 

• CLKOUT 0: Desired Frequency Value – 100 MHz, used for cpu0 and the AHB bus. 

• CLKOUT 1: Desired Frequency Value – 50 MHz, used for the APB bus. 

• CLKOUT 2: Desired Frequency Value – 150 MHz, used as tx_ref_clk and sync_clk for the parallel2mipi and 
mipi2parallel modules. 

3.1.1.3. cpu0 

cpu0 is the 32-bit RISC-V based CPU instantiated in the propelbld_soc_w_m2p_p2m module to interface the other 
components (UART, GPIOs, mipi2parallel, parallel2mipi, and so on) with the software design. This component is also 
used for UART communication with the host and to control on-board LEDs.  

The following guidelines and parameter settings are required for this reference design: 

• C Extension for Compressed Instructions – Checked 

• M Extension for Integer Mult and Div – Checked 

• Debug Enabled – Checked. This option enables the JTAG port to the CPU to allow debugging with OpenOCD. 

• Soft JTAG - Checked 

http://www.latticesemi.com/legal
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• PIC Enable – Checked 

• Timer Enable – Checked 

• PIC and Timer Base Address – 32’hFFFF0000 

• Number of Interrupt Requests – 2 

• JTAG Channel Selection – 14 

• Enable AHBL Data Output Register – Checked 

3.1.1.4. ahbl0 

ahbl0 module is an AHB-Lite Interconnect IP which connects system memory (system0) and other peripherals to the 
cpu0 module in the propelbld_soc_w_m2p_p2m block. AHBL_M00 bus connects to the system0’s AHBL_S01 bus, while 
AHBL_M01 bus connects to the ahbl2apb0 module.  

The following guidelines and parameter settings are required for this reference design: 

• Total AHB-Lite Managers – 1 

• Total AHB-Lite Subordinates – 2 

• Manager Address Width – 32 

• Data Bus Width – 32 

• Manager 0 Subordinate 0 Connect Enable – Checked 

• Manager 0 Subordinate 1 Connect Enable – Checked 

• For other tabs, use parameter default settings  

3.1.1.5. ahbl2apb0 

ahbl2apb0 is an AHB-Lite to APB bridge IP that creates a bridge between APB interconnect (apb0) to the AHB 
interconnect (ahbl0) in the propelbld_soc_w_m2p_p2m block. The AHBL_S0 bus of this module connects to the 
AHBL_M01 of the ahbl0 module.  

The following guidelines and parameter settings are required for this reference design: 

• Address Width – 32 bits 

• Data Bus Width – 32 bits 

• APB Clock Enable – Checked 

3.1.1.6. apb0 

apb0 is a module of the APB Interconnect IP in the propelbld_soc_w_m2p_p2m block. This APB interconnect module 
connects a UART module (uart0), a gpio module (gpio0), and APB feedthrough modules (apb_ft_txdphy, 
apb_ft_rxdphy, apb_ft_pll, apb_ft_pcg).  

The following guidelines and parameter settings are required for this reference design: 

• Total APB Requestor – 1 

• Total APB Completers – 6 

• Requestor Address Width – 32 bits 

• Data Bus Width – 32 bits 

3.1.1.7. system0 

system0 is a module generated from the System Memory IP which stores the instruction and data for cpu0 execution 
instantiated in the propelbld_soc_w_m2p_p2m block.  

The following guidelines and parameter settings are required for this reference design: 

• Interface – AHBL 

• Memory Address Depth – 8192 

• Data Bus Width – 32 bits 

• Memory Type – EBR 

• Port Count – 2 

• ECC Enable – Unchecked 

• Enable Arbiter – Unchecked 

• Enable Data Streamer – Unchecked 

• Initialize Memory – Checked 

http://www.latticesemi.com/legal
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• Initialization File Format – Hex 

• Initialization File – The .mem file is generated after each of Lattice Propel SDK software build. Locate the file in the 
<design directory> /fpga_lavat/propelsdk/propelsdk_soc_w_m2p_p2m_4/Debug. 

3.1.1.8. uart0 

uart0 is a module generated from the UART IP which is instantiated in the propelbld_soc_w_m2p_p2m block. This 
module enables cpu0 and the host to be communicated via UART serial interface (for example, printing logs to the 
Lattice Propel SDK software console).  

The following guidelines and parameter settings are required for this reference design: 

• System Clock Frequency – 50 MHz 

• Serial Data Width – 8 

• Stop Bits – 1 

• Parity Enable – Unchecked 

• Baud Rate Type – Standard 

• UART Standard Baud Rate – 115200 

• FIFO Enable – Unchecked 

• RX Ready Enable – Unchecked 

• TX Ready Enable – Unchecked 

3.1.1.9. gpio0 

gpio0 is a module generated from the GPIO IP which is instantiated in the propelbld_soc_w_m2p_p2m block. This 
module allows cpu0 to interact with the FPGA I/O. In this reference design, all 8 I/O are assigned to the on-board LEDs.  

The following guidelines and parameter settings are required for this reference design:  

• Number of I/O Lines – 8 

• Remove Tri-State Buffer – Checked 

• Initial Output Value – 0 

• IO Direction – 0xFF 

• Interface – APB 

3.1.1.10. apb_ft 

apb_ft is a module generated with the APB Feedthrough IP which instantiated in the propelbld_soc_w_m2p_p2m 
block. The four instances of this module that are instantiated are apb_ft_rxdphy, apb_ft_txdphy, apb_pgc, and apb_pll. 
These instances allow the APB buses to be exposed out from the propelbld_soc_w_m2p_p2m module and connected 
manually to the serial_loopback_top module on the top level of this reference design (soc_w_m2p_p2m_top).  

The following guidelines and parameter settings are required for this reference design:  

• Address Width – 10 bits 

• Data Bus Width – 32 bits 

• Enable PSLVERR signal – Checked 

• Export Interface as – Completer 

• Memory Map Width – 10 bits 

3.1.2. serial_loopback_top 

This module is the main hardware design of the MIPI-to-Parallel and Parallel-to-MIPI reference design. This module 
instantiates the MIPI-to-Parallel (mipi2parallel) and Parallel-to-MIPI (parallel2mipi) modules, PLL (sys_pll), Pattern 
Generator and Checker (patgen_chk_wrapper), and APB to LMMI bridges (apb2lmmi) as described in  
Figure 3.3. All the IPs in this module are generated using the Lattice Radiant software. To change IP configuration, you 
must modify the IPs using the Lattice Radiant software. 
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tx_clkos (90-degree shift)

pix_clk

 

Figure 3.3. serial_loopback Block Diagram 

3.1.2.1. apb2lmmi 

As most of the IPs (rx_dphy, tx_dphy) and the custom Pattern Generator and Checker design implement LMMI 
interface for a control interface, a custom bridge between APB and LMMI design is created to interface those IPs and 
designs with the CPU to enable controllability using software. 

Note that to be consistent with the design at the CPU (the propelbld_soc_w_m2p_p2m module), all the data of APB are 
32 bits wide. For the IP or module that has less than 32 bits of data in a single address, zeros are added as the most 
significant bits. All the LMMI offsets are mapped to APB address by multiplying by them by a factor of four. For 
example, if the LMMI offset is 0x1, the corresponding APB address is 0x4. 

3.1.2.2. sys_pll 

sys_pll is the PLL module instantiated to generate all the necessary clocks for this reference design.  

The following guidelines and parameter settings are required for this reference design: 

• Set Maximum Error Option – Use the specified tolerance value 

• Set Number of Clock Outputs – 3 

• Enable Fractional Accumulation – Checked 

• Reference Clock: Frequency – 50 MHz, coming from osc0_inst. 

• PLL outputs: 

• CLKOUT0 (clkop_o) – Used by tx_dphy in the parallel2mipi module as the clkop pin. This is the D-PHY clock 
frequency with a 0-degrees phase shift. 

• CLKOUT1 (clkos_o) – Used by tx_dphy in the parallel2mipi module as the clkos pin. This is the D-PHY clock 
frequency with a 90-degrees phase shift. 

• CLKOUT2 (clkos2_o) – Generates pixel clock for the Pixel-to-Byte IP and Byte-to-Pixel IP.  

• Provide PLL Reset – Checked 

• Provide PLL Lock Signal – Checked 

• Select Register Interface – APB. This allows dynamic reconfiguration of the PLL to switch to a different clock 
frequency when performing dynamic reconfiguration on the DPHY’s bitrate.  

• Register Offset – Address offset in DWORD 

3.1.2.3. parallel2mipi 

parallel2mipi is an RTL wrapper that connects the Pixel-to-Byte Converter IP (p2b) and CSI-2/DSI D-PHY Transmitter IP 
(tx_dphy). 

Figure 3.4 and Figure 3.5 show examples of input bus waveform to the p2b module that is converted into byte data for 
the tx_dphy IP. Then, tx_dphy IP converts those byte data into MIPI D-PHY packets to be transmitted out. 
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Figure 3.4. Display (DSI) Input Bus Waveform 
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LV

PIXDATA

[word_width-1:0]

 

Figure 3.5. Camera (CSI-2) Input Bus Waveform 

The submodules in the parallel2mipi module are described in the subsequent subsections. 

p2b 

This module is instantiated within the Parallel-to-MIPI block to convert pixel data into byte data output according to 
configurations, such as Tx Interface, Data Type, number of Tx Lanes, and other settings. Refer to the Pixel-to-Byte 
Converter IP Core User Guide (FPGA-IPUG-02094) for more details. 

The following guidelines and parameter settings are required for this reference design: 

• Data Type – Select RGB888, RAW8, RAW10, RAW12, RAW14, RAW16, YUV420_8, YUV422_8, YUV420_10, or 
YUV422_10. Other types are not supported in this reference design. 

• Number of Input Pixel Lanes – Select 1, 2, or 4 input pixel per clock. 

• Pixel Clock Frequency – Set to the target pixel clock frequency after dynamic reconfiguration. The default is 100 
MHz.  

• Enable AXI4-Stream Receiver Interface – OFF  

• Receiver Data Rate – Automatically calculated. It is recommended that the value be the same as the Transmitter 
Data Rate to have the same FIFO read and write frequency.  

• TX Interface – Select CSI-2 or DSI. Set the same type as the Tx D-PHY IP.  

• DSI Mode – Available only for DSI. Set to Non-Burst Pulses (default). 

• Number of TX Lanes – Select 1, 2, or 4. Set the same value as the Tx D-PHY IP.  

• TX Gear – Select 8. Set the same value as the Tx D-PHY IP. 

• Byte Clock Frequency – Set to the target byte clock frequency after dynamic reconfiguration. The default is 150 
MHz.  

• Enable AXI4-Stream Transmitter Interface – OFF  

• Transmitter Data Rate – Automatically calculated. It is recommended that the value is the same as the Receiver 
Data Rate to have the same FIFO read and write frequency. 

• Enable APB Interface – OFF 

• Enable Line Valid Masks Signals – Available for CSI-2. OFF (default). 

• Word Count – Enter the appropriate value using the following equation: 

• Word Count = (NUM_PIXELS × PD_BUS_WIDTH) ÷ 8 

• For example: In case of 240 pixel with RGB888, the value is (240 × 24) ÷ 8 = 720 
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• Manual Adjust – Unchecked (disabled). 

The Pixel-to-Byte Converter IP converts the standard pixel data format to the D-PHY CSI-2/DSI standard based byte data 
stream. The .ipx file included in the project (p2b/p2b.ipx) can be used to reconfigure the IP per your configuration 
requirements. If you create this IP from scratch, it is recommended to set the design name to p2b so that you do not 
need to modify the instance name of this IP in the top-level design. Otherwise, you need to modify the names 
accordingly. 

tx_dphy 

This module is instantiated within the Parallel-to-MIPI block and created according to the channel conditions, such as 
number of lanes, bandwidth, and other settings. Refer to CSI-2/DSI D-PHY Tx IP User Guide (FPGA-IPUG-02080) for 
more details. 

The following guidelines and parameter settings are required for this reference design: 

• TX Interface Type – Select CSI-2 or DSI. Set according to the required configuration. 

• D-PHY TX IP – SOFT D-PHY (non-configurable). 

• Number of TX Lanes – Select 1, 2, or 4. Set according to the required configuration. 

• TX Gear – Gear 8 (non-configurable).  

• Bypass Packet Formatter – Unchecked (disabled). 

• Enable LMMI Interface – Checked (enabled) to allow register access through the LMMI interface.  

• Enable AXI4-Stream Interface – Unchecked (disabled). 

• EoTp Enable (DSI) – Unchecked (disabled). 

• Enable Frame Number Increment in Packet Formatter (CSI-2) – Checked (enabled). 

• Frame number MAX Value Increment in Packet Formatter (CSI-2)  – set to 1 

• Enable Line Number Increment in Packet Formatter (CSI-2)  – Unchecked (disabled).  

• Extended Virtual Channel ID (CSI-2)  – Unchecked (disabled).  

• Target TX Line Rate (Mbps per Lane) – Set according to the required configuration 

• D-PHY Clock Mode – Set Continuous or Non-Continuous according to the required configuration 

• Enable Edge Clock Synchronizer and Divider – Checked (enabled) 

• Reference Clock Frequency (MHz) [24 – 200] – Set the value according to the tx_ref_clk_i frequency in the 
parallel2mipi block. The default is 150 MHz, coming from the pll0_inst module. 

• Enable tINIT Counter – Checked (Enabled). 

• tINIT Counter Value – 1000 (default value). 

• Enable Miscellaneous Status Signals – Checked (enabled). 

• Protocol Timing Parameters tab – Default values are recommended, change timing values if required. 

This module takes the byte data and outputs DSI/CSI-2 data after serialization in DSI/CSI-2 High Speed mode. The .ipx 
file included in the project (tx_dphy/tx_dphy.ipx) can be used to reconfigure the IP per your configuration 
requirements. If you create this IP from scratch, it is recommended to set the design name to tx_dphy so that you do 
not need to modify the instance name of this IP in the top-level design. Otherwise, you need to modify the names 
accordingly. 

3.1.2.4. mipi2parallel 

The parallel2mipi is an RTL wrapper that connects the Byte-to-Pixel Converter IP (b2p) and CSI-2/DSI D-PHY Receiver IP 
(rx_dphy). 

The parallel transmit interface consists of clock, pixel data, and control signals. The pixel data width is configurable 
depending on the data type. The control signals are either data enable (DE), vertical and horizontal sync flags (VSYNC 
and HSYNC) for MIPI DSI applications, or frame valid and line valid for MIPI CSI-2 applications. 

The clock is edge-aligned against data and control signals. All signal transitions happen in sync with the rising edge of 
pixel clock as shown in Figure 3.6 and Figure 3.7. 
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Figure 3.6. Parallel Transmit Interface Timing Diagram (DSI) 
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fv_o

pixel_data

lv_o

 

Figure 3.7. Parallel Transmit Interface Timing Diagram (CSI-2) 

b2p 

This module must be created for the Rx interface according to the required configuration, such as data type, the 
number of lanes, Rx Gear, and other settings. Refer to the Byte-to-Pixel Converter IP Core User Guide (FPGA-IPUG-
02079) for more details. 

The following guidelines and parameter settings are required for this reference design: 

• Data Type – Select RGB888, RAW8, RAW10, RAW12, RAW14, RAW16, YUV420_8, YUV422_8, YUV420_10, or 
YUV422_10. Other types are not supported in this reference design. 

• RX Interface – Select CSI-2 or DSI. Set the same type as the Rx D-PHY IP. 

• DSI Mode – Available for DSI. Set to Non-Burst Pulses.  

• Number of RX Lanes – Select 1, 2 or 4. Set the same value as the Rx D-PHY IP. 

• RX Gear – Select 8. Set the same value as the Rx D-PHY IP. 

• Byte Clock Frequency – Set to the target byte clock frequency after dynamic reconfiguration. The default is 150 
MHz.  

• Enable AXI4-Stream Receiver Interface – Unchecked (disabled). 

• Number of Output Pixel Lanes – Select 1 or 2 

• Camera/Display Control Polarity – Select Positive. If you are using Negative polarity, select this option as Positive 
and use Negative polarity defined in synthesis_directives.v. 

• DSI Sync Packet Delay – Available for DSI. Set to 5 (default value). 

• Pixel Clock Frequency – Set to the target pixel clock frequency after dynamic reconfiguration. The default is 100 
MHz.  

• Pixel-Side Transmitter Interface – Native Interface 

• Manual Adjust – Unchecked (disabled). 

• FIFO Implementation – EBR  

• Word Count – Enter the appropriate value using the following equation: 

• Word Count = (NUM_PIXELS × PD_BUS_WIDTH) ÷ 8 

• For example: In case of 240 pixel with RGB888, the value is (240 × 24) ÷ 8 = 720 

• Enable Debug Ports – Unchecked (disabled). 
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• Register Interface – OFF 

The Byte-to-Pixel Converter IP converts the D-PHY CSI-2/DSI standard based byte data stream to standard pixel data 
format. The .ipx file included in the project (b2p/b2p.ipx) can be used to reconfigure the IP per your configuration 
requirements. If you create this IP from scratch, it is recommended to set the design name to b2p so that you do not 
need to modify the instance name of this IP in the top-level design. Otherwise, you need to modify the names 
accordingly. 

rx_dphy 

This module must be created for the Rx interface according to the required configuration, such as the number of lanes, 
bandwidth, and other settings. Refer to CSI-2/DSI D-PHY Rx IP User Guide (FPGA-IPUG-02081) for more details. 

The following shows guidelines and parameter settings required for this reference design: 

• RX Interface Type – Select CSI-2 or DSI (set according to the required configuration). 

• D-PHY RX IP – SOFT D-PHY (non-configurable). 

• Number of D-PHY Data Lanes – Set according to the Rx interface configuration (set according to the required 
configuration). 

• RX Gear – Gear 8 (non-configurable). 

• Enable Deskew Calibration Detection – Unchecked (disabled). 

• RX Line Rate – Set according to the Rx interface configuration.  

• D-PHY Clock Mode – Select Continuous or Non-continuous (set according to the required configuration). 

• Sync Clock Frequency – Set the value according to the sync_clk_i frequency in the mipi2parallel block. The default 
is 150 MHz coming from the pll0_inst module.  

• Enable Lane Aligner Module – Checked (enabled). 

• Enable Packet Parser – Checked (enabled). 

• Enable AXI4-Stream Interface – Unchecked (disabled). 

• Enable LMMI Interface – Checked (enabled). 

• Enable Miscellaneous Status Signals – Checked (enabled). 

• Enable CRC Check – Unchecked (disabled). 

• Customize Data Settle Cycle – Unchecked (disabled). 

• Parameters in RX_FIFO Settings tab – Use default settings 

This module takes serial CSI-2/DSI data and outputs byte data after de-serialization in MIPI High Speed mode. The .ipx 
file included in the project (rx_dphy/rx_dphy.ipx) can be used to reconfigure the IP per your configuration 
requirements. If you create this IP from scratch, it is recommended to set the design name to rx_dphy so that you do 
not need to modify the instance names of these IPs in top level design. Otherwise, you need to modify the names 
accordingly. 

3.1.2.5. patgen_chk_wrapper 

pattern_gen protocol_pktzr

lmmi_pgc_parser

pat_chk

pgc_lmmi_bus

pixel data,

pixel valid

pixel request

stimulus parameter

test status

Transmitted pixel data,

Control signals (fv, lv, de, hsync, vsync)

Received pixel data

 

Figure 3.8. patgen_chk_wrapper High Level Block Diagram 
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This reference design incorporates custom components such as the Pattern Generator (pattern_gen), Pattern Checker 
(pat_chk), LMMI Parser (lmmi_pgc_parser), and Protocol Packetizer (protocol_pktzr) modules. This module acts as a 
synthetic test stimulus for the Parallel-to-MIPI reference design and compare the stimulus to the received pixel data of 
MIPI-to-Parallel reference design. Figure 3.8 shows the high-level block diagram of the patgen_chk_wrapper module. 
The following table shows the register map of this module. 

Table 3.1. patgen_chk_wrapper Register Map 

Offset Name Access Description 

0x0 PGC_DUT_CONTROL RW resetn signal to the DUT. 

0x1 PGC_TST_CONTROL RW Test control register for num_frames, polarity, fifo_empty, sticky_test, and 
drop_frames. 

0x2 PGC_TST_STATUS RO Test status register for test_done, run_flag, and test_result. 

0x3 PGC_VID_TIM_HBP RW Video timing horizontal back porch register 

0x4 PGC_VID_TIM_HSC RW Video timing horizontal sync register 

0x5 PGC_VID_TIM_HCT RW Video timing horizontal active register 

0x6 PGC_VID_TIM_HFP RW Video timing horizontal front porch register 

0x7 PGC_VID_TIM_VBP RW Video timing vertical back porch register 

0x8 PGC_VID_TIM_VSC RW Video timing vertical sync register 

0x9 PGC_VID_TIM_VCT RW Video timing vertical active register 

0xA PGC_VID_TIM_VFP RW Video timing vertical front porch register 

 

pattern_gen 

The pattern_gen module supports up to two user-selectable pattern types—PRBS or Colorbar—and generates pixel 
data according to the specified data width. Colorbar is only supported for data type of RGB888 and 1 pixel per clock 
(PPC) mode, while the current PRBS implementation only generates 8-bits pseudo-random data. For the data type and 
pixel per clock combination that requires the output data to be larger than 8 bits, the LSBs are repeated for MSBs. For 
example, if the PRBS generated 0xAB, and the output data is 16 bits wide, the output data is 0xABAB. Timing diagram in 
Figure 3.9 shows 3 cycles delay between pix_req_i assertion and de-assertion to the valid pixel outputs. 

pixel_clk

pix_req_i

tx_datavalid_o

pix_data_o

 

Figure 3.9. pattern_gen Timing Diagram 

protocol_pktzr 

The Protocol Packetizer module receives pixel data from the Pattern Generator and other signals from LMMI Parser 
and produces valid CSI-2 (fv, lv) signals into the Pixel-to-Byte module. Figure 3.10 and Figure 3.11 show the timing 
diagram of the generated lv_o and fv_o against the defined design parameters as described in the Reference Design 
Parameter Description section. 

pixel_clk

fv_o

lv_o

pix_data_o

pix_req_o

 

Figure 3.10. protocol_pktzr Timing Diagram Per Line 
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fv_o

 

Figure 3.11. protocol_pktzr Timing Diagram Per Frame 

pat_chk 

The Pattern Checker module stores the pixel data from the Pattern Generator in a FIFO and compares the pixel data 
with the incoming data from the Byte-to-Pixel module. If the data matches, the test_result_o signal from the Pattern 
Checker module is asserted; the signal is de-asserted in the event of a data mismatch. 

lmmi_pgc_parser 

This module acts as a bridge between control and status signals to the LMMI interface. The default value of each 
register is defined by the compiler directives as described in the Reference Design Parameter Description section. 

3.2. Clocking Scheme 

3.2.1. Clocking Overview 

MIPI2Parallel Reference Design

Parallel2MIPI Reference Design

pattern_gen protocol_pktzr p2b tx_dphy

rx_dphyb2ppat_chk

tx_byte_clk clock domain
tx_dphy clkop_i 

and clkos_i

rx_clk_byte_fr clock domain

rx_dphy 
byte_clk_hs_o

pix_clk clock domain

 

Figure 3.12. Reference Design Clock Domain Block Diagram 

Figure 3.12 shows the clock domains of the data path of the designs. 

• The pixel clock domain (pix_clk) is used when the data is already in pixel format. Sync signals also use this domain. 
This clock is generated by CLKOS2 of the sys_pll module. 

• Tx byte clock domain (tx_byte_clk) is used when the data is in the byte format and to be consumed by tx_dphy. 
This clock is generated by tx_dphy module by dividing the clkop_i pins. 

• Tx D-PHY clock domain (tx_dphy clkop_i and clkos_i) is used to transmit D-PHY packets over the D-PHY channel: 

• tx_dphy clkop_i is generated by CLKOP of the sys_pll module. 

• tx_dphy clkos_i is generated by CLKOS of the sys_pll module. 

• Rx D-PHY write byte clock (rx_dphy byte_clk_hs_o) is used to capture the D-PHY byte data into a built-in FIFO of 
the rx_dphy. This clock is generated by dividing the D-PHY clock lanes by the number of gears. 

• Rx D-PHY free running byte clock (rx_clk_byte_fr) is used to read data from the built-in FIFO of the rx_dphy: 

• In continuous clock mode, this clock is the same as rx_dphy byte_clk_hs_o. 

• In non-continuous clock mode, this clock comes from Tx D-PHY’s byte_clk_o. 
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3.3. Reset Scheme 

3.3.1. Reset Overview 

The system level reset is routed to the resetn_i pin of the top-level module as an active-low reset. Asserting this reset 
asynchronously resets all modules, including sub-modules in the System on Chip (SoC) and serial loopback modules. 
After the system reset is released, modules in the SoC block (for example, cpu0, osc0, pll0) and configuration 
interconnects (AHB-Lite, APB, LMMI) are out of reset.  

The primary reset of the serial_loopback_top and the submodules can be controlled using software by modifying the 
bit 0 of register PGC_DUT_CONTROL (dut_reset_n). To ensure the correctness of the design, this reset must be toggled 
for at least 100 ns after the bit rate is changed using software. 

The parallel2mipi and mipi2parallel modules also use the following signals to reset the block: 
assign rstn = dut_resetn && dphy_reg_wr_done && resetn_i && pll_locked_i; 

 

// dut_resetn is a software-controlled reset signal that writes to PGC_DUT_CONTROL register 

// dphy_reg_wr_done is an optional software-controlled signal after write to D-PHY registers 

// resetn_i is an on-board system level reset with push-button 

// pll_locked_i is from sys_pll module to check for PLL lock signal after PLL dynamic 

reconfiguration 

 

All the reset signals are asynchronously asserted, and synchronously de-asserted with the respective clock domains. 
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4. Reference Design Parameter Description 
The MIPI-to-Parallel and Parallel-to-MIPI reference design includes the parameters shown in Table 4.1, Table 4.2, and 
Table 4.3. You can modify the parameters by editing the synthesis_directives.v file for the design, and the 
simulation_directives.v file for the RTL simulation testbench. Note that the parameters must match with the IP 
configurations respectively. 

Table 4.1. Design Parameters in synthesis_directives.v 

Parameter Default Value Description 

DPHY_DEBUG_ON DPHY_DEBUG_ON Enables debug signals in the designs. Comment out this parameter 
to disable. 

NUM_DPHY_LANES_1 

NUM_DPHY_LANES_2 

NUM_DPHY_LANES_4 

NUM_DPHY_LANES_4 Number of MIPI D-PHY lanes to be used in the design. 

DPHY_CLK_MODE_HS_ONLY 

DPHY_CLK_MODE_HS_LP 

DPHY_CLK_MODE_HS_ONLY Sets the mode for D-PHY clock mode. 

HS_ONLY – Continuous Clock Mode 

HS_LP – Non-continuous Clock Mode 

DPHY_GEAR_8 DPHY_GEAR_8 Number of Gears. Only Gear 8 is valid. 

PROTOCOL_CSI2 

PROTOCOL_DSI 

PROTOCOL_CSI2 Defines the protocol to be used. 

DT_RGB666 

DT_RGB888 

DT_RAW8 

DT_RAW10 

DT_RAW12 

DT_RAW14 

DT_RAW16 

DT_YUV420_8 

DT_YUV420_10 

DT_YUV422_8 

DT_YUV422_10 

DT_RGB888 Defines the data types to be transmitted or received. 

NUM_PIX_LANE_1 

NUM_PIX_LANE_2 

NUM_PIX_LANE_4 

NUM_PIX_LANE_2 Defines the number of pixel lanes (or pixel per clock). Note that 
not all modes are available for a given combination of data types 
and number of lanes. 

 

Table 4.2. Pattern Generator and Checker Parameters in synthesis_directives.v1 

Parameter Default Value Description 

DEFAULT_T_HBP2 13’d600 Horizontal back porch period (in pixel clock cycle). The value must be at 
least 3 or larger. 

DEFAULT_T_HSC2 13’d44 Horizontal sync porch period (in pixel clock cycle). 

DEFAULT_T_HCT3 13’d240 Horizontal active period (in pixel clock cycle). 

DEFAULT_T_HFP2 13’d600 Horizontal front porch period (in pixel clock cycle). 

DEFAULT_T_VBP4,5 13’d4 Vertical back porch period (in number of lines). 

DEFAULT_T_VSC4,5 13’d5 Vertical sync porch period (in number of lines). 

DEFAULT_T_VCT4,5 13’d5 Vertical active period (in number of lines). 

DEFAULT_T_VFP4,5 13’d5 Vertical front porch period (in number of lines). 

DEFAULT_TEST_NUM_FRAMES 8’d2 Number of frames to be tested (inclusive of dropped frames). 

DEFAULT_FIFO_EMPTY_FAIL 1’b0 0 – Do not check for checker’s FIFO empty as fail. 

1 – Flag checker’s FIFO empty as fail. 

DEFAULT_STICKY_TEST_RESULT 1’b1 0 – Test result is not sticky. 

1 – Test result is sticky. 

DEFAULT_DROP_FRAMES 4’d1 Number of the first N frames to be ignored by the checker. 
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Parameter Default Value Description 

PATTERN_TYPE PRBS PRBS – Uses 8-bit PRBS data for pattern generator. 

COLORBAR – Uses RGB888 color bar for pattern generator.6 

Notes: 

1. The directives values are the default values of the pattern generator and checker registers. 

2. For CSI-2 mode, DEFAULT_T_HBP + DEFAULT_T_HSC + DEFAULT_T_HFP is used as a horizontal blanking period. 

3. The design assumed DEFAULT_HCT is the largest active period for this configuration to calculate the necessary FIFO depth. 

4. For CSI-2 mode, DEFAULT_T_VBP + DEFAULT_T_VSC + DEFAULT_T_VFP is used as a vertical blanking period. 

5. To speed up simulation, you can reduce vertical timing parameters accordingly. 

6. COLORBAR is only supported for RGB888 data type with 1 pixel per clock. 

Table 4.3. Simulation Parameters in simulation_directives.v 

Parameter Default Value Description 

REFCLK_PER 10000 Period of the external reference clock in ps. 

SIM_DBG_MODULE Undefined Uncomment this directive to enable additional simulation modules for 
debugging. 

 

Table 4.4. Lattice Propel SDK Software Parameter in param_def.h 

Parameter Default Value Description 

BITRATE 1200 Tx and Rx D-PHY target bitrate for dynamic reconfiguration 

DATA_TYPE 0x24 MIPI data type as defined in the Byte-to-Pixel and Pixel-to-Byte IPs. 

CSI2_RGB888       = 0x24 

CSI2_RAW8          = 0x2A 

CSI2_RAW10        = 0x2B 

CSI2_RAW12        = 0x2C 

CSI2_RAW14        = 0x2D 

CSI2_RAW16        = 0x2E 

CSI2_YUV420_8   = 0x18 

CSI2_YUV420_10 = 0x19 

CSI2_YUV422_8   = 0x1E 

CSI2_YUV422_10 = 0x1F 

DSI_RGB666         = 0x2E 

DSI_RGB888         = 0x3E 

CLK0_PHI1 0x01 sys_pll IP PLL parameter 

CLK1_PHI1 0x05 sys_pll IP PLL parameter 

CLK2_PHI1 0x01 sys_pll IP PLL parameter 

CLK3_PHI1 0x01 sys_pll IP PLL parameter 

CLK4_PHI1 0x01 sys_pll IP PLL parameter 

CLK5_PHI1 0x01 sys_pll IP PLL parameter 

CLK0_DEL1 0x06 sys_pll IP PLL parameter 

CLK1_DEL1 0x07 sys_pll IP PLL parameter 

CLK2_DEL1 0x36 sys_pll IP PLL parameter 

CLK3_DEL1 0x01 sys_pll IP PLL parameter 

CLK4_DEL1 0x01 sys_pll IP PLL parameter 

PLL_CLKR1 0x00 sys_pll IP PLL parameter 

PLL_CLKF1 0x120000 sys_pll IP PLL parameter 

PLL_CLKV1 0x00 sys_pll IP PLL parameter 

PLL_BWADJ1 0x11 sys_pll IP PLL parameter 

PLL_CLKOD01 0x05 sys_pll IP PLL parameter 

PLL_CLKOD11 0x05 sys_pll IP PLL parameter 

PLL_CLKOD21 0x23 sys_pll IP PLL parameter 
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Parameter Default Value Description 

PLL_CLKOD31 0x00 sys_pll IP PLL parameter 

PLL_CLKOD41 0x00 sys_pll IP PLL parameter 

DBG_PRINT Commented Enables printf status and debug messages through UART. Comment out 
this parameter to reduce simulation time.  

LOOP_COUNT 1 Software run loop count 

NUM_FRAMES 2 Number of frames to be transmitted 

DROP_FRAMES 1 Number of drop frames 

Note: 

1. The values defined in these parameters are used to dynamically configure sys_pll (D-PHY Tx clkop, D-PHY Tx clkos, and pix_clk) 
to generate a new clock frequency. You can open the PLL IP Module or IP Block Wizard in the Radiant software and open the 
DEBUG: PLL Parameters tab to determine the correct parameter values. 
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5. Signal Description 
The input/output interface signals for the soc_w_m2p_p2m_top.v module are shown in Table 5.1. 

Table 5.1. Primary I/O 

Port Name Input/Output Width Description 

resetn_i Input 1 System wide reset signal 

uart_rxd_i Input 1 UART Rx input 

uart_txd_o Output 1 UART Tx output 

clk_p_tx_io Input/Output 1 CSI-2/DSI D-PHY Transmitter Clock pin 

clk_n_tx_io Input/Output 1 CSI-2/DSI D-PHY Transmitter Clock pin 

d_p_tx_io[NUM_TX_LANE-1:0]1 Input/Output NUM_TX_LANE CSI-2/DSI D-PHY Transmitter Data pin 

d_n_tx_io[NUM_TX_LANE-1:0]1 Input/Output NUM_TX_LANE CSI-2/DSI D-PHY Transmitter Data pin 

clk_p_rx_io Input/Output 1 CSI-2/DSI D-PHY Receiver Clock pin 

clk_n_rx_io Input/Output 1 CSI-2/DSI D-PHY Receiver Clock pin 

d_p_rx_io[NUM_RX_LANE-1:0]1 Input/Output NUM_RX_LANE CSI-2/DSI D-PHY Receiver Data pin 

d_n_rx_io[NUM_RX_LANE-1:0]1 Input/Output NUM_RX_LANE CSI-2/DSI D-PHY Receiver Data pin 

led_o[7:0] Output 8 General purpose outputs to on-board LEDs 

dbg_led_o[1:0] Output 2 0 - Run test status , 1 - Test result status 

riscv_tck_i Input 1 JTAG signal 

riscv_tdi_i Input 1 JTAG signal 

riscv_tms_i Input 1 JTAG signal 

riscv_tdo_o Output 1 JTAG signal 

Note: 

1. NUM_RX_LANE and NUM_TX_LANE are set to be equal in this design, which is defined by the NUM_DPHY_LANES_{1-4} in 
synthesis_directives.v. 
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6. Running the Reference Design 
This section describes how to run the MIPI-to-Parallel and Parallel-to-MIPI reference design using the Lattice Radiant 
software. For more details on the Lattice Radiant software, refer to the Lattice Radiant Software User Guide. 

6.1. Opening the Reference Design Project 

6.1.1. Radiant Main Project File 

To open the reference design main project file, follow these steps:  

1. Open the Lattice Radiant software. 

2. Click File > Open Project and from the project database, open the Lattice Radiant software project file (.rdf) from 
the <design_directory>/fpga_lavat/radiant directory. This opens the reference design project. 

Note: The Radiant main project file also contains IPs that are generated using the Propel Builder software. To modify 
these IPs, you must use the Propel Builder software.  

6.1.2. Propel Builder Project File 

Follow these steps to open the Propel Builder project of the reference design:  

1. Open Lattice Propel Builder software. 
2. Click File > Open Design and from the project database, open .sbx file from the 

<design_directory>/fpga_lavat/radiant/propelbld_soc_w_m2p_p2m directory. This opens the Lattice Propel 
Builder project of the reference design.  

Note: For each modification on the IP or Propel Builder project, you must click the Generate ( ) button for the 
changes to be reflected in the main Radiant project.  

6.1.3. Propel SDK Project File 

The reference design also contains software source code to interface with the RISC-V CPU to manage the dynamic 
reconfiguration flow. Follow these steps to open the software project file:  

1. Open the Lattice Propel SDK software.  
2. Within the Lattice Propel Laucher interface, set the Workspace to the <design_directory>/fpga_lavat/propelsdk 

directory and click Launch. This opens the software project of the reference design. 
Notes:  

• If the project does not appear after setting up the Workspace, you need to import the project by following these 
steps: 

a. Navigate to Import Projects > General > Existing Projects into Workspace > Next. 

b. Assign root directory to <design_directory>/fpga_lavat/propelsdk/propelsdk_soc_w_m2p_p2m_4. 

c. Click Finish. 

• For every modification on the software project, you must rebuild the software by clicking Project > Build Project. 
This action generates a new .mem file located at <design_directory>/fpga_lavat/propelsdk/ 
propelsdk_soc_w_m2p_p2m_4/Debug. You need to configure system0 in the Propel Builder software to use the 
.mem file as the Initialization File. 
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6.2. Compiling and Generating the Bitstream File 
This section provides the procedure for creating your FPGA bitstream file using the Lattice Radiant software. However, 
the reference design package also includes a precompiled FPGA bitstream file, located in the 
<design_folder>/fpga_lavat/precompiled_file directory, which you can use to run the hardware test directly. 
To compile and create a new FPGA bitstream file using the Lattice Radiant software, follow these steps: 

1. Open the Lattice Radiant software and reference design project as mentioned in the Radiant Main Project File 
section. 

2. Click the Export Files ( ) button to generate the bit file. View the log message in the Export Reports 
folder for the generated bitstream. 

3. Locate new bitstream file in the impl1 directory.  
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7. Simulating the Reference Design 
To simulate the design, perform the following steps: 

1. Unzip the reference design .zip file. 

2. Open the reference design project file (propelbld_soc_w_m2p_p2m.rdf) using the Lattice Radiant software as 
mentioned in the Radiant Main Project File section.  

3. To modify the stimulus sent (resolution, blanking periods, and other data), you can manually modify the compiler 
directives, as documented in Table 4.1 and Table 4.2. 

4. You can also define the SIM_DBG_MODULE directive, as described in Table 4.3, to enable additional debug 
modules to assist in RTL simulation debugging. 

5. Open the QuestaSim simulator from the Radiant software.  

6. Using QuestaSim Transcript, navigate to the <design_directory>/fpga_lavat/sim/questa directory. 

7. Run the script using the following command: 
VSIM 12> do run_sim.do 

7.1. Simulation Results 
When the simulation succeeds, logs are printed in the Transcript window, as shown in Figure 7.1. 

 

Figure 7.1. Simulation Log 

Figure 7.2 shows some of the signals after running the script. You can add more signals in QuestaSim and rerun the 
simulation by issuing the following command: 
restart -f; 

run -all; 
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Figure 7.2. List of Signals in the Wave View from the wave.do File 

The following provides a high-level explanation of the simulation waveform shown above:  

1. The software-controlled reset is asserted.  

2. The sys_pll configuration is in progress. GPIO[1] is asserted to indicate that the PLL has been configured.  

3. The software writes to the D-PHY Tx and Rx IP registers (tx_tlpx, tx_tclk_hszero, tx_tclk_post, and others) for a 
1,200 Mbps bitrate. GPIO[0] is asserted once this is completed.  

4. The software-controlled reset is de-asserted. The sys_pll output now running at 600 MHz for PLL CLKOP and CLKOS 
(with a 90-degree phase shift), and 150 MHz for CLKOS2 after pll_locked signal is asserted. The Tx and Rx D-PHY are 
now running at 1,200 Mbps.  

5. The test is now running, comparing the transmitted and received pixel data. 

6. The test_result signal remains asserted, indicating that the pixel data matches. 

7. The test is complete. 
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8. Implementing the Reference Design on Board 
The MIPI-to-Parallel and Parallel-to-MIPI reference design can be evaluated using the Lattice Avant Evaluation Board 
Rev D. The additional required hardware is listed as follows: 

• HW-USB-2B Programming cable – Required to interface the software with the CPU JTAG pins using OpenOCD in the 
Lattice Propel SDK. 

• FMC Loopback Card – Required to establish a loopback path between the Tx D-PHY and Rx D-PHY. 

8.1. Hardware Setup 

 

Figure 8.1. Lattice Avant Evaluation Board Revision D Setup with Additional Hardware 

Figure 8.1 shows the full setup required to implement MIPI-to-Parallel and Parallel-to-MIPI reference design on the 
Lattice Avant Evaluation Board. For modifications needed on the board compared to the default configuration, follow 
these steps: 

1. Install FMC Loopback Card on FMC2 connector (J54). 

2. Install HW-USB-2B JTAG pins on the Parallel FMC1 Configuration Header (J10). 

3. To program the SRAM in Lattice Avant devices, set SW7 to JTAG position. 

4. Set VCCIO on Bank 4 to 1.2 V by opening JP75 and JP76, and closing JP61. 
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8.2. Programming the Board 
To program the board, follow these steps: 

1. Modify the reference design configuration and complete the compilation to generate bitstream, as described in the 
Compiling and Generating the Bitstream File section. Alternatively, you may use the precompiled bitstream file that 
comes with this reference design. 

2. Connect both USB cables from the Lattice Avant Evaluation Board and HW-USB-2B programming cable to the host 
machine. 

3. Launch the Lattice Radiant Programmer, and program the board as shown in Figure 8.2. 

4. Click the Program Device ( ) icon to start program the FPGA device. 

 

Figure 8.2. The Lattice Radiant Programmer Setup 

5. The DONE LED on the board lights up after a successful programming. 

8.3. Using Debug Console and Serial Terminal in Lattice Propel Software 
1. Launch the Lattice Propel software version 2025.1 and set the workspace to 

<design_directory>/fpga_lavat/propelsdk directory, as mentioned in the Propel SDK Project File section. 

Note: Ensure board has been programmed. Refer to the Programming the Board section for steps.  

2. Launch the Serial Terminal as shown in the example in Figure 8.3. Note that the serial port may vary from host to 
host. 
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Figure 8.3. Launching Serial Terminal 

3. Set up cable connection configuration for OpenOCD by navigating to Run > Debug Configurations > GDB OpenOCD 
Debugging > propelsdk_soc_w_m2p_p2m_4 Debug. 

4. Select the port that is connected to the HW-USBN-2B cable, as shown in Figure 8.4. Note that when using Soft JTAG 
for the RISC-V CPU, Scan Device does not show any device. 

 

Figure 8.4. Cable Connection Setup 
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5. Close the Debug Configuration window. 

6. You can now write C code or use the existing example code in main.c. 

7. Compile and build the design by navigating to Project > Build Project. 

8. Click the Run ( ) button to run the code. 

9. Some of the Console output is shown in Figure 8.5. 

 

Figure 8.5. Console Log on Running OpenOCD 
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8.4. Hardware Test Result 
For the demo hardware test, the design dynamically configures the PLL and D-PHY Tx and Rx to a 1,200 Mbps bitrate, 
while simultaneously comparing the input and output pixel data of the Pixel-to-Byte and Byte-to-Pixel modules.  

To view the result, go to the Terminal tab and analyze the results based on the printout log. 

 

Figure 8.6. Example Log 

Alternatively, you can monitor the on-board LEDs LED0 to LED4 (D6–D10). The LED statuses as described in Table 11.1 
and shown in the following figure. 

  

Figure 8.7. Successful Hardware Test LED Output  
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9. Customizing the Reference Design 

9.1. Using the Excel Calculator Helper 
The reference design includes a simple calculator that helps you determine the D-PHY clock, byte clock, and pixel clock 
frequencies required by the MIPI D-PHY Tx and Rx, as well as the Byte-to-Pixel and Pixel-to-Byte IP blocks. The 
calculator can be found in the <design_directory>/misc directory. 

 

Figure 9.1. Excel Calculator tool 

9.2. Dynamic Configuration to Other Bitrates 
Reference design provides an example of dynamic configuration to 1,200 Mbps bitrate. To change to other bitrates, 
refer to the following steps.  

9.2.1. Lattice Radiant Software 

1. Modify synthesis_directives.v as per your design requirements, such as the number of D-PHY lanes, the selected 
protocol, and the video data type.  

2. Ensure the parameter defined in the Byte-to-Pixel and Pixel-to-Byte IPs match those in synthesis_directives.v. After 
updating the IP parameters, make sure to click Generate. 

3. Confirm that the Tx and Rx D-PHY IPs use the same number of lanes, interface type, and clock mode as defined in 
synthesis_directives.v. After updating the IP parameters, make sure to click Generate. 

9.2.2. Lattice Propel SDK 

1. Update param_def.h to define the dynamic reconfiguration parameters, including the target bitrate, video data 
type, and PLL parameter settings of sys_pll required for reconfiguration. You can open the sys_pll IP in the Radiant 
software to determine the correct PLL parameters for CLKOP/CLKOS (D-PHY clock) and CLKOS2 (pixel clock) based 
on the target frequency. 

2. Rebuild the software after completing the updates. This generates a .mem file in the software project Debug folder.  

9.2.3. Lattice Propel Builder Software  

1. Open system0 and add the newly generated .mem file as the Initialization File.  

2. Click the Generate ( ) icon to regenerate the project. The Radiant project is refreshed. You can now proceed with 
design simulation or full design compilation in the Radiant software. 
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9.3. Standalone MIPI-to-Parallel and Parallel-to-MIPI Reference Design 
You can implement standalone MIPI-to-Parallel and Parallel-to-MIPI reference designs. Note that there are no 
standalone RTL simulation or standalone hardware test available for each of the design. You can verify your target 
configurations using the MIPI-to-Parallel and Parallel-to-MIPI reference design first before proceeding to extract the 
standalone MIPI-to-Parallel or Parallel-to-MIPI designs. 

9.3.1. MIPI-to-Parallel Standalone Design 

1. For MIPI-to-Parallel standalone design (static configuration), you may copy the following files into your new project 
file:  

• mipi2parallel.v 

• synthesis_directives.v 

• b2p.ipx 

• rx_dphy.ipx 

2. You may assign the reset_n_i signal input of the mipi2parallel module to an external push button reset. 

3. Refer to the serial_loopback_top module (<design_directory>/fpga_lavat/radiant/src/rtl/serial_loopback_top.v) 
and the Clocking Scheme section for guidance on clock sourcing for the design. 

9.3.2. Parallel-to-MIPI Standalone Design 

1. For Parallel-to-MIPI standalone design (static configuration), you may copy the following files into your new project 
file:  

• Parallel2mipi.v 

• synthesis_directives.v 

• p2b.ipx 

• tx_dphy.ipx 

2. You may assign the reset_n_i signal input of the parallel2mipi module to an external push button reset. 

3. Refer to the serial_loopback_top module (<design_directory>/fpga_lavat/radiant/src/rtl/serial_loopback_top.v) 
and the Clocking Scheme section for guidance on clock sourcing for the design. 
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10. Resource Utilization 
Resource utilization depends on the configuration used. Table 10.1 shows the resource utilization examples under 
certain configurations targeting LAV-AT-E70 devices. This table is for reference only and actual usage may vary. 

Table 10.1. Resource Utilization 

Configuration LUT4 FPU Register EBR I/O Buffers 

4-lanes, continuous clock mode, CSI-2, RGB888, 2 pixel/clock  14408 7472 17 37 

4-lanes, non-continuous clock mode, CSI-2, RGB888, 2 pixel/clock  14395 7486 17 37 

4-lanes, non-continuous clock mode, DSI, RGB888, 2 pixel/clock  14379 7515 18 37 

4-lanes, continuous clock mode, DSI, RGB888, 2 pixel/clock 14350 7508 18 37 
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11. Debugging 
This section lists possible issues and suggested troubleshooting steps that you can follow. 

11.1. Debug Tools 
You can use various tools to debug the MIPI-to-Parallel and Parallel-to-MIPI reference design issues. 

11.1.1. LED Debug 

The reference design uses on-board LEDs (LED0 to LED4) to simplify monitoring of its runtime status during hardware 
test. 

Table 11.1. On-board LED status 

LED Status Description 

LED0 (D6) On Test is running 

Off Test is not running 

LED1 (D7) On Test passed 

Off Test failed 

LED2 (D8) On Software is done writing to D-PHY registers  

Off Software is not done writing to D-PHY registers 

LED3 (D9) On Software is done configuring PLL registers  

Off Software is not done configuring PLL registers 

LED4 (D10) On Dynamic reconfiguration test completed 

Off Dynamic reconfiguration test not completed 

LED5–LED15 — Unused  

 

11.1.2. Reveal Analyzer 

The Reveal™ Analyzer continuously monitors signals within the FPGA for specific conditions, ranging from simple to 
complex. When a trigger condition occurs, the Reveal Analyzer saves signal values preceding, during, and following the 
event for analysis, including a waveform presentation. The data can be saved in the following format: 

• Value change dump file (.vcd) that can be used with tools such as QuestaSim™. 

• ASCII tabular format that can be used with tools such as Microsoft® Excel. 

Before running the Reveal Analyzer, use the Reveal Inserter to add Reveal modules to your design. In these modules, 
specify the signals to monitor, define the trigger conditions, and other preferred options. The Reveal Analyzer supports 
multiple logic analyzer cores using hard/soft JTAG interface. You can have up to 15 modules, typically one for each 
clock region of interest. When the modules are set up, regenerate the bitstream data file to program the FPGA. 

During debug cycles, this tool uses a divide and conquer method to narrow down the problem areas into many small 
functional blocks to control and monitor the status of each block. 

Refer to Reveal User Guide for Radiant Software for details on how to use the Reveal Analyzer. Refer to the simulation 
wave.do file from the Simulation Results section to identify some of the critical signals that can be viewed with the 
Reveal Analyzer. 

11.1.3. Propel Terminal 

The Lattice Propel SDK includes a built-in terminal tool with serial support for microcontroller debugging. You can 
utilize this tool to monitor software flow status, such as printf messages after completing PLL register writes, DPHY 
register writes, and dynamic reconfiguration. For detailed instructions on using this feature, refer to the Using Debug 
Console and Serial Terminal in Lattice Propel Software section. 
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12. Known Limitations 
• Only RGB888, RAW8, RAW10, RAW12, RAW14, RAW16, YUV420_8, YUV422_8, YUV420_10, and YUV422_10 data 

types are supported. 

• The data bandwidth for pixel clock and byte clocks domains (pix_clk, tx_byte_clk, rx_clk_byte_fr, and 
byte_clk_hs_o) must be equal. 

• Dynamic reconfiguration on lanes is not supported in this reference design.  

• You need to wait at least 100 ns to release the reset after performing dynamic reconfiguration. 
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References 
• Byte-to-Pixel Converter IP User Guide (FPGA-IPUG-02079) 

• Pixel-to-Byte Converter IP Core User Guide (FPGA-IPUG-02094) 

• CSI-2/DSI D-PHY Tx IP User Guide (FPGA-IPUG-02080) 

• CSI-2/DSI D-PHY Rx IP User Guide (FPGA-IPUG-02081) 

• Reveal User Guide for Radiant Software 

• MIPI DSI/CSI-2 to Parallel Bridge Reference Design web page 

• Parallel to MIPI CSI-2/DSI Display Interface Bridge Reference Design web page 

• Avant-E web page 

• Lattice Radiant Software web page 

• Lattice Propel Design Environment web page 

• Lattice Solutions Reference Designs web page 

• Lattice Insights web page for Lattice Semiconductor training courses and learning plans 
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Technical Support Assistance 
Submit a technical support case through www.latticesemi.com/techsupport. 

For frequently asked questions, please refer to the Lattice Answer Database at 
www.latticesemi.com/Support/AnswerDatabase. 
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Revision History 

Revision 1.1, July 2025 

Section Change Summary 

All Made editorial fixes. 

Abbreviations in This Document Added CMOS, CPU, DPI, DUT, FPGA, FPU, GPIO, HDL, I/O, IP, JTAG, LED, LMMI, LSB, LVCMOS, 
LVDS, MC, RGB, RISC-V, SDK, and UART. 

Introduction • Updated the test bench format, software and tool versions, and IP versions in Table 1.1. 
Summary of the Reference Design. 

• Updated the MIPI D-PHY interfacing support and added the dynamic reconfiguration 
support in the Features section. 

Directory Structure and Files Updated Figure 2.1. Directory Structure. 

Functional Description • Updated Figure 3.1. Reference Design Block Diagram, Figure 3.2. soc_w_m2p_p2m Block 
Diagram, and Figure 3.3. serial_loopback Block Diagram. 

• Renamed the Propel Builder module to propelbld_soc_w_m2p_p2m. 

• Updated the descriptions in the following sections: 

• Design Components 

• propelbld_soc_w_m2p_p2m (including all subsections) 

• serial_loopback_top (including all subsections) 

• Clocking Overview 

• Reset Overview 

• Renamed the int_gpll section to sys_pll.  

• Removed the following figures: 

• Figure 3.3. osc0 IP Generation in the Lattice Propel Builder – Figure 3.12. apb_ft IP 
Generation in the Lattice Propel Builder 

• Figure 3.14. int_gpll IP Generation in the Lattice Radiant Software – General Tab – 
Figure 3.15. int_gpll IP Generation in the Lattice Radiant Software – Optional Ports 
Tab 

• Figure 3.18. p2b IP Generation in the Lattice Radiant Software – Figure 3.19. tx_dphy 
IP Generation in the Lattice Radiant Software 

• Figure 3.22. b2p IP Creation in the Lattice Radiant Software – Figure 3.23. rx_dphy IP 
Creation in the Lattice Radiant Software 

Reference Design Parameter 
Description 

• Updated the description in this section. 

• Updated Table 4.1. Design Parameters in synthesis_directives.v and Table 4.2. Pattern 
Generator and Checker Parameters in synthesis_directives.v1. 

• Added Table 4.4. Lattice Propel SDK Software Parameter in param_def.h. 

Signal Description In Table 5.1. Primary I/O: 

• Removed refclk0_i. 

• Added the dbg_led_o[1:0] port. 

• Updated descriptions for JTAG ports. 

Running the Reference Design • Added the Opening the Reference Design Project section. 

• Renamed the Compiling and Generating the Bitstream File section and updated its 
content. 

Simulating the Reference Design Updated this section. 

Implementing the Reference 
Design on Board 

• Updated descriptions in the following sections: 

• Implementing the Reference Design on Board 

• Programming the Board 

• Hardware Test Result 

• Renamed the Using Debug Console and Serial Terminal in Lattice Propel Software section 
and updated its content. 

• Updated Figure 8.2. The Lattice Radiant Programmer Setup – Figure 8.6. Example Log. 

Customizing the Reference 
Design 

Updated this section. 
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Section Change Summary 

Resource Utilization Updated Table 10.1. Resource Utilization. 

Debugging • Removed the following sections: 

• Debut Methods 

• OpenOCD Debugger 

• Added the following sections: 

• LED Debug 

• Propel Terminal 

• In the Reveal Analyzer section, updated ModelSim to QuestaSim. 

Known Limitations • Removed CSI-2 and int-gpll module limitations. 

• Added lane dynamic reconfiguration and reset duration limitations.  

References Added the Lattice Solutions Reference Designs web page. 

 

Revision 1.0, June 2024 

Section Change Summary 

All Production release.  
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